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This document applies to the following vector network analyzer models and their options:
® R&S®ZNB4, 9 kHz to 4.5 GHz, 2 test ports, order no. 1311.6010K22

® R&S®ZNB4, 9 kHz to 4.5 GHz, 2 test ports, order no. 1334.3330K22

® R&S®ZNB4, 9 kHz to 4.5 GHz, 4 test ports, order no. 1311.6010K24

® R&S®ZNB4, 9 kHz to 4.5 GHz, 4 test ports, order no. 1334.3330K24

® R&S®ZNB8, 9 kHz to 8.5 GHz, 2 test ports, order no. 1311.6010K42

® R&S®ZNBS8, 9 kHz to 8.5 GHz, 2 test ports, order no. 1334.3330K42

® R&S®ZNB8, 9 kHz to 8.5 GHz, 4 test ports, order no. 1311.6010K44

® R&S®ZNBS, 9 kHz to 8.5 GHz, 4 test ports, order no. 1334.3330K44

® R&S®ZNB20, 100 kHz to 20 GHz, 2 test ports, order no. 1311.6010K62

® R&S®ZNB20, 100 kHz to 20 GHz, 2 test ports, order no. 1334.3330K62

® R&S®ZNB20, 100 kHz to 20 GHz, 4 test ports, order no. 1311.6010K64

® R&S®ZNB20, 100 kHz to 20 GHz, 4 test ports, order no. 1334.3330K64

® R&S®ZNB26, 100 kHz to 26.5 GHz, 2 test ports, order no. 1334.3330K63

® R&S®ZNB26, 100 kHz to 26.5 GHz, 4 test ports, order no. 1334.3330K65

® R&S®ZNB40, 10 MHz to 40 GHz, 2 test ports, order no. 1311.6010K72

® R&S®ZNB40, 100 kHz to 40 GHz, 2 test ports, order no. 1311.6010K82

® R&S®ZNB40, 100 kHz to 40 GHz, 4 test ports, order no. 1311.6010K84

® R&S®ZNB43, 100 kHz to 43.5 GHz, 2 test ports 2.92 mm, order no. 1334.3330K92
® R&S®ZNB43, 100 kHz to 43.5 GHz, 2 test ports 2.4 mm, order no. 1334.3330K93
® R&S®ZNB43, 100 kHz to 43.5 GHz, 4 test ports 2.92 mm, order no. 1334.3330K94
® R&S®ZNB43, 100 kHz to 43.5 GHz, 4 test ports 2.4 mm, order no. 1334.3330K95

® R&S®ZNBTS, 9 kHz to 8.5 GHz, 4 test ports (up to 24 ports optional),
order no. 1318.7006K24

® R&S®ZNBT20, 100 kHz to 20 GHz, 8 test ports (up to 24 ports optional),
order no. 1332.9002K24

® R&S®ZNBT20, 100 kHz to 20 GHz, 8 test ports (up to 24 ports optional),
order no. 1332.9002K64

® R&S®ZNBT26, 100 kHz to 26.5 GHz, 8 test ports (up to 24 ports optional),
order no. 1332.9002K34

® R&S®ZNBT40, 100 kHz to 40 GHz, 8 test ports (up to 24 ports optional),
order no. 1332.9002K44
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R&S®ZNB Safety and regulatory information

1.1

Safety instructions

Safety and regulatory information

The product documentation helps you use the product safely and efficiently. Follow the
instructions provided here and in the following sections.

Intended use

The product is intended for the development, production and verification of electronic
components and devices in industrial, administrative, and laboratory environments.
Use the product only for its designated purpose. Observe the operating conditions and
performance limits stated in the specifications document.

Target audience

The target audience of this document includes developers and technicians, administra-
tors and maintenance personnel performing RF signal measurements. The required
skills and experience of the users depend on the test setup and application of the prod-
uct.

Where do | find safety information?

Safety information is part of the product documentation. It warns you of potential dan-
gers and gives instructions on how to prevent personal injury or damage caused by
dangerous situations. Safety information is provided as follows:

® |n Section 1.1, "Safety instructions”, on page 7. The same information is provi-
ded in many languages in printed format. The printed "Safety Instructions" for
"Mains-Powered Products, Not Heavy" (document number 1171.1771.99) are deliv-
ered with the product.

® Throughout the documentation, safety instructions are provided when you need to
take care during setup or operation.

Safety instructions

Products from the Rohde & Schwarz group of companies are manufactured according
to the highest technical standards. To use the products safely, follow the instructions
provided here and in the product documentation. Keep the product documentation
nearby and offer it to other users.

Use the product only for its intended use and within its performance limits. Intended
use and limits are described in the product documentation such as the specifications
document, manuals and the printed "Safety Instructions" document. If you are unsure
about the appropriate use, contact Rohde & Schwarz customer support.

Using the product requires skilled persons or specially trained personnel. These users
also need sound knowledge of at least one of the languages in which the user interfa-
ces and the product documentation are available.

Getting Started 1316.0062.02 — 69 7
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Safety instructions

Reconfigure or adjust the product only as described in the product documentation or
the specifications document. Any other modifications can affect safety and are not per-
mitted.

Never open the casing of the product. Only service personnel authorized by

Rohde & Schwarz are allowed to repair the product. If any part of the product is dam-
aged or broken, stop using the product. Contact Rohde & Schwarz customer support at
https://www.rohde-schwarz.com/support.

Lifting and carrying the product

The maximum weight of the product is provided in the specifications document. You
can lift or carry the product by yourself, if you can manage the weight on your own.
Alternatively, you can use lifting or transporting equipment. Follow the instructions pro-
vided by the equipment manufacturer.

Choosing the operating site

Only use the product indoors. The product casing is not waterproof. Water that enters
can electrically connect the casing with live parts, which can lead to electric shock,
serious personal injury or death if you touch the casing.

If Rohde & Schwarz provides accessories designed for outdoor use of your product,
e.g. a protective cover, you can use the product outdoors.

You can operate the product up to an altitude of 2000 m above sea level. If a higher
altitude is permissible, the value is provided in the specifications document. The prod-
uct is suitable for pollution degree 2 environments where nonconductive contamination
can occur. For more information on environmental conditions such as ambient temper-
ature and humidity, see the specifications document.

Setting up the product

Always place the product on a stable, flat and level surface with the bottom of the prod-
uct facing down. If the product is designed for different positions, secure the product so
that it cannot fall over.

If the product has foldable feet, always fold the feet completely in or out to ensure sta-
bility. The feet can collapse if they are not folded out completely or if the product is
moved without lifting it. The foldable feet are designed to carry the weight of the prod-
uct, but not an extra load.

If stacking is possible, keep in mind that a stack of products can fall over and cause
injury.

If you mount products in a rack, ensure that the rack has sufficient load capacity and
stability. Observe the specifications of the rack manufacturer. Always install the prod-
ucts from the bottom shelf to the top shelf so that the rack stands securely. Secure the
product so that it cannot fall off the rack.

Connecting the product

Before connecting the interfaces or measuring inputs of the product to other products
or electrical circuits, make sure that the other products or electrical circuits provide
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Safety instructions

special protection against electric shock. This protection principle is referred to as
SELV (safety extra-low voltage) and is based on a low voltage level and increased
insulation. Exceptions are indicated by a measurement category on the product and
given in the specifications document.

Connecting to power

The product is an overvoltage category Il product. Connect the product to a fixed
installation used to supply energy-consuming equipment such as household applian-
ces and similar loads. Keep in mind that electrically powered products have risks, such
as electric shock, fire, personal injury or even death. Replace parts that are relevant to
safety only by original parts, e.g. power cables or fuses.

Take the following measures for your safety:

® Before switching on the product, ensure that the voltage and frequency indicated
on the product match the available power source. If the power adapter does not
adjust automatically, set the correct value and check the rating of the fuse.

® |f a product has an exchangeable fuse, its type and characteristics are indicated
next to the fuse holder. Before changing the fuse, switch off the product and dis-
connect it from the power source. How to change the fuse is described in the prod-
uct documentation.

® Only use the power cable delivered with the product. It complies with country-spe-
cific safety requirements. Only insert the plug into an outlet with protective conduc-
tor terminal.

® Only use intact cables and route them carefully so that they cannot be damaged.
Check the power cables regularly to ensure that they are undamaged. Also ensure
that nobody can trip over loose cables.

® Only connect the product to a power source with a fuse protection of maximum
20 A.

® Ensure that you can disconnect the product from the power source at any time.
Pull the power plug to disconnect the product. The power plug must be easily
accessible. If the product is integrated into a system that does not meet these
requirements, provide an easily accessible circuit breaker at the system level.

Cleaning the product

Use a dry, lint-free cloth to clean the product. When cleaning, keep in mind that the
casing is not waterproof. Do not use liquid cleaning agents.

Meaning of safety labels

Safety labels on the product and its accessories warn against potential hazards.

Potential hazard

Read the product documentation to avoid personal injury or product damage.

Indicates live parts. Risk of electric shock, fire, personal injury or even death.

f Electrical hazard
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Korea certification class A

Hot surface
Do not touch. Risk of skin burns. Risk of fire.

Protective conductor terminal
Connect this terminal to a grounded external conductor or to protective ground. This connec-
tion protects you against electric shock if an electric problem occurs.

1.2 Warning messages in the documentation

A warning message points out a risk or danger that you need to be aware of. The sig-
nal word indicates the severity of the safety hazard and how likely it will occur if you do
not follow the safety precautions.

WARNING

Potentially hazardous situation. Could result in death or serious injury if not avoided.

NOTICE

Potential risks of damage. Could result in damage to the supported product or to other
property.

1.3 Korea certification class A

o] 7171E AF-&(AT) DA A7) 7] ZA DA} EE AFERE o] HE F3A] Y]
vhep | 7 9 o] A Gol A AL E AL B4 o7 syt
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Instrument security procedures

2 Documentation overview

This section provides an overview of the R&S ZNB user documentation. Unless speci-
fied otherwise, you find the documents at:

2.1 Getting started manual

Introduces the R&S ZNB and describes how to set up and start working with the prod-
uct. Includes basic operations, typical measurement examples, and general informa-
tion, e.g. safety instructions, etc.

A printed version is delivered with the instrument. A PDF version is available for down-
load on the Internet.

2.2 User manual and help

The user manual contains the description of all instrument modes and functions. It also
provides an introduction to remote control, a complete description of the remote control
commands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

The contents of the user manual are available as help in the R&S ZNB. The help offers
quick, context-sensitive access to the complete information for the instrument and its
firmware.

The user manual is also available for download or for immediate display on the Inter-
net.

2.3 Service manual

Describes the performance test for checking the rated specifications, module replace-
ment and repair, firmware update, troubleshooting and fault elimination, and contains
mechanical drawings and spare part lists.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

R&S ZNB Classified Service Document

2.4 Instrument security procedures

Deals with security issues when working with the R&S ZNB in secure areas. It is avail-
able for download on the internet.
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2.5

2.6

2.7

2.8

Application notes, application cards, white papers, etc.

Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

Specifications document and brochure

The specifications document, also known as the data sheet, contains the technical
specifications of the R&S ZNB. It also lists the firmware applications and their order
numbers, and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

https://www.rohde-schwarz.com/brochure-datasheet/ZNB.

Release notes and open source acknowledgment
(OSA)

The release notes list new features, improvements and known issues of the current
software version, and describe the software installation.

The software uses several valuable open source software packages. An open source
acknowledgment document provides verbatim license texts of the used open source
software.

https://www.rohde-schwarz.com/firmware/ZNB.

An HTML version of the OSA is installed with the analyzer firmware. It can be opened
from the main menu of the VNA's graphical user interface ("Help">"About">"Open
Source Acknowledgment: Open...").

Application notes, application cards, white papers,
etc.

These documents deal with special applications or background information on particu-
lar topics.

https://www.rohde-schwarz.com/application/ZNB
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R&S®ZNB Preparing for use

3

3.1

3.2

3.3

Choosing the operating site

Preparing for use

Here, you can find basic information about setting up the product for the first time.

Lifting and carrying
The carrying handles are designed to lift or carry the instrument. Do not apply exces-
sive external force to the handles.

See "Lifting and carrying the product" on page 8.

Unpacking and checking

1. Unpack the R&S ZNB carefully.

2. Retain the original packing material. Use it when transporting or shipping the
R&S ZNB later.

3. Using the delivery notes, check the equipment for completeness.
4. Check the equipment for damage.

If the delivery is incomplete or equipment is damaged, contact Rohde & Schwarz.

Choosing the operating site

Specific operating conditions ensure proper operation and avoid damage to the prod-
uct and connected devices. For information on environmental conditions such as ambi-
ent temperature and humidity, see the specifications document.

For safety information, see "Choosing the operating site" on page 8.

Electromagnetic compatibility classes
The electromagnetic compatibility (EMC) class indicates where you can operate the
product. The EMC class of the product is given in the specifications document.
® C(Class B equipment is suitable for use in:
— Residential environments

— Environments that are directly connected to a low-voltage supply network that
supplies residential buildings

® C(Class A equipment is intended for use in industrial environments. It can cause
radio disturbances in residential environments due to possible conducted and radi-
ated disturbances. It is therefore not suitable for class B environments.
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Setting up the product

If class A equipment causes radio disturbances, take appropriate measures to
eliminate them.

3.4 Setting up the product

See also:
® "Setting up the product” on page 8
® ‘"Intended use" on page 7

3.4.1 Placing the product on a bench top

To place the product on a bench top

1. Place the product on a stable, flat and level surface. Ensure that the surface can
support the weight of the product. For information on the weight, see the specifica-
tions document.

2. CAUTION! Foldable feet can collapse. For safety information, see "Setting up the
product" on page 8.
Always fold the feet completely in or out. With folded-out feet, do not place any-
thing on top or underneath the product.

3. WARNING! A stack of products can fall over and cause injury. Never stack more
than three products on top of each other. Instead, mount them in a rack.

Stack as follows:

If the products have foldable feet, fold them in completely.
It is best if all products have the same dimensions (width and length). If the
products have different dimensions, stack according to size and place the
smallest product on top.

e Do not exceed the permissible total load placed on the product at the bottom of
the stack:
— 50 kg when stacking products of identical dimensions (left figure).
— 25 kg when stacking smaller products on top (middle figure).

]
|
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|
|
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Setting up the product

Left = Stacked correctly, same dimensions
Middle = Stacked correctly, different dimensions
Right = Stacked incorrectly, too many products

NOTICE! Overheating can damage the product.

Prevent overheating as follows:

e Keep a minimum distance of 10 cm between the fan openings of the product
and any object in the vicinity to provide sufficient airflow and ventilation.

e Do not place the product next to heat-generating equipment such as radiators
or other products.

3.4.2 Mounting the product in a rack

To prepare the rack

1.
2.

Observe the requirements and instructions in "Setting up the product" on page 8.

NOTICE! Insufficient airflow can cause overheating and damage the product.
Design and implement an efficient ventilation concept for the rack.

To mount the R&S ZNB in a rack

1.

Use an adapter kit to prepare the R&S ZNB for rack mounting.

a) Order a suitable rack adapter kit.
See the specifications document.

b) Mount the adapter kit. Follow the assembly instructions provided with the
adapter Kkit.

Lift the R&S ZNB to shelf height.

Grab the handles and push the R&S ZNB onto the shelf until the rack brackets fit
closely to the rack.

Tighten all screws in the rack brackets with a tightening torque of 1.2 Nm to secure
the R&S ZNB in the rack.

To unmount the R&S ZNB from a rack

1.
2.
3.

Loosen the screws at the rack brackets.
Remove the R&S ZNB from the rack.

If placing the R&S ZNB on a bench top again, unmount the adapter kit from the
R&S ZNB. Follow the instructions provided with the adapter Kkit.
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Considerations for test setup

3.5 Considerations for test setup

Cable selection and electromagnetic interference (EMI)
Electromagnetic interference (EMI) can affect the measurement results.

To suppress electromagnetic radiation during operation:

® Use high-quality shielded cables, for example, double-shielded RF and LAN
cables.

® Always terminate open cable ends.
® Ensure that connected external devices comply with EMC regulations.

Regarding length and quality, the following requirements have to be met for cables that
are directly connected to the R&S ZNB:

Table 3-1: Cable Requirements

Cable Type (Connector) Requirement

RF cables (PORT 1, ..., PORT N) Double shielded
BNC cables (various) Double shielded
DB-25 (USER PORT) Double shielded

Digital /0 (Direct Control

R&S ZN-B121, order no. 1323.9290.00

GPIB Standard cable
Handler I/O Standard cable
RFFE/GPIO R&S ZN-Z25 (order no. 1334.3424.02)

DisplayPort (Monitor)

Standard cable

HDMI (Monitor)

Standard cable

DVI-D (Monitor)

2 ferrite cores

LAN At least CAT6, S/FTP
PCle Standard cable
USB Standard cables, length < 3m

Signal input and output levels

Information on signal levels is provided in the specifications document. Keep the signal
levels within the specified ranges to avoid damage to the product and connected devi-
ces.

Preventing electrostatic discharge (ESD)

Electrostatic discharge is most likely to occur when you connect or disconnect a DUT.

» NOTICE! Electrostatic discharge can damage the electronic components of the
product and the device under test (DUT).

Ground yourself to prevent electrostatic discharge damage:
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Switching the instrument on and off

a) Use a wrist strap and cord to connect yourself to ground.
b) Use a conductive floor mat and heel strap combination.

During operation, if the firmware observes a serious unexpected disturbance (e.g. due
to ESD), it resets all hardware components to ensure proper instrument functioning. It
then restores the user settings to the state before the disturbance and indicates the
foregone hardware reset by an "Hardware communication problem [...]" information

popup.

3.6 Connecting the analyzer to the AC supply

For safety information, see "Connecting to power" on page 9.

The network analyzer is automatically adapted to the AC supply voltage, which must
be in the range of 100 V to 240 V at 50 Hz to 60 Hz. A line frequency of 400 Hz is also
supported.

The AC power connector is located in the upper part of the rear panel (see Section 4.2,
"Rear panel", on page 33).

1. Plug the AC power cable into the AC power connector on the rear panel of the
product. Only use the AC power cable delivered with the product.

2. Plug the AC power cable into a power outlet with ground contact.
The required ratings are listed next to the AC power connector and in the specifica-
tions document.

3. If necessary, also ground the product using the grounding terminal <.

The maximum power consumption and the typical power consumption of the individual
analyzer models are listed in the specifications document.

3.7 Switching the instrument on and off

To switch on the R&S ZNB

1. Switch the AC power switch to position I (On).
The AC power switch is located in the upper part of the rear panel, together with
the mains connector and the fuse drawer; see Section 4.2, "Rear panel",
on page 33.

After power-on, the analyzer automatically goes to standby or ready state, depend-
ing on the state of the standby toggle key at the front panel when the instrument
was switched off last time.

2. If necessary, press the standby toggle key on the front panel to switch the instru-
ment to the ready state.
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3.9

Windows operating system

See Section 3.8, "Standby and ready state", on page 18.

The instrument automatically performs a system check, boots the Windows® oper-
ating system and then starts the vector network analyzer (VNA) application. If it
was terminated regularly, the VNA application restores all recall sets and instru-
ment settings of the previous analyzer session.

To shut down the instrument

1. Press the standby toggle key.

Pressing the standby toggle key causes the instrument to save all loaded recall
sets, to close the VNA application, to shut down Windows®, and to go to standby
state (see Section 3.8, "Standby and ready state", on page 18).

Of course, you can also perform these steps manually, like in any Windows ses-
sion.

2. If desired, set the AC power switch to position O (Off).

To disconnect from power
Prerequisite: The R&S ZNB is in standby state.

1. NOTICE! Risk of data loss. If you disconnect the product from power when it is in
the ready state, you can lose settings and data. Shut it down first.
Set the switch on the power supply to position [0].

The LED of the standby toggle key key is switched off.

2. Disconnect the R&S ZNB from the power source.

Standby and ready state

The standby toggle key is located in the bottom-left corner of the front panel. In
standby state, the right, amber LED is on, in ready state, the left, green LED is on.

The standby power only supplies the power switch circuits and the optional high preci-
sion quartz (R&S ZNB-B4). In this state, it is safe to switch the AC power off and dis-
connect the instrument from the power supply. In ready state, all modules are power-
supplied. When switched to ready state, the analyzer initiates its startup procedure.

Observe the instructions for startup and shutdown in Section 3.7, "Switching the instru-
ment on and off", on page 17.

Windows operating system

The analyzer is equipped with a Windows® operating system, which has been config-
ured according to the instrument's features and needs. Changes in the system configu-
ration can be necessary to:

® Establish a LAN connection.
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e (Customize the properties of the external accessories connected to the analyzer.
e (Call up additional software tools.

All necessary settings can be accessed from the Windows "Start" menu, in particular
from the "Control Panel". To open the "Start" menu, press the Windows key in the tool-
bar or on an external keyboard.

Modifications of the operating system

The operating system is adapted to the network analyzer. To avoid impairment of
instrument functions, only change the settings described in this manual.

Only execute programs that are authorized by Rohde & Schwarz for use on the instru-
ment. Only modify installed software with updates released by Rohde & Schwarz.

User accounts and password protection

The analyzer uses a user name and password as credentials for remote access. Two
user accounts with different levels of access are available on the instrument:

® "instrument" is the default account with standard rights to change system settings.
Use this account for normal operation of the analyzer.

e "Admin" is the account for administering the operating system. This account is
required, for instance, if you wish to install programs on the analyzer.

In the factory configuration, "894129" is preset as a password for both users. To protect
the analyzer from unauthorized access, it is recommended to change the preset pass-
words.

To switch from one user account to another, log off from Windows and then log on
again. The "switch user" functionality is disabled on the R&S ZNB.

Security updates and patches

Microsoft regularly creates security updates and other patches to protect Windows-
based operating systems. They are released through the Microsoft Update website and
associated update server. Update instruments using Windows regularly, especially
instruments that connect to a network.

The analyzer is equipped with a Windows 10 loT Enterprise LTSB/LTSC operating sys-
tem, which is the embedded version of Windows 10 with long-term support for Win-
dows security updates and patches. The firmware is tested with the following OS ver-
sions:

® Windows 10 IoT Enterprise 2016 LTSB
® Windows 10 loT Enterprise 2019 LTSC
® Windows 10 IoT Enterprise 2021 LTSC
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Minimizing the VNA application

Firewall settings

A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. Rohde & Schwarz highly recommends using the firewall on
your instrument. Rohde & Schwarz instruments are shipped with the Windows firewall
enabled. All ports and connections for remote control are enabled.

Note that changing firewall settings requires administrator rights.

Virus protection

Take appropriate steps to protect your instruments from infection. Use strong firewall
settings and scan any removable storage device used with a Rohde & Schwarz instru-
ment regularly. It is also recommended that you install anti-virus software on the instru-
ment. Rohde & Schwarz does NOT recommend running anti-virus software in the
background ("on-access" mode) on Windows-based instruments, due to potentially
degrading instrument performance. However, Rohde & Schwarz does recommend run-
ning it during non-critical hours.

For details and recommendations, see the Rohde & Schwarz white paper 1EF96: Mal-
ware Protection Windows 10.

3.10 Minimizing the VNA application
With a minimized VNA application, you can access your analyzer's Windows® desktop
or run other applications.

To exit the default full-screen mode of the VNA application, deselect System — [Display]
> "View Bar" > "Title Bar Task Bar". Then use the standard Windows® title bar functions
to minimize/maximize/close the application window.

To start the VNA application with a minimized window
1. Right-click the Vector Network Analyzer shortcut icon on the Windows desktop.
2. Open the "Properties" dialog.

3. In the "Shortcut" tab, select "Run: Minimized".
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Security Details Previous Versions
General Shorteut Compatibility

@ R&S Vector Network Analyzer

Target type: Application
Tanget location: Bin

Target: warzVector Netwark Analyzer' ™ \Bin'\Vna exe

Start in:

Shortcut key: | None |

Run: | Normal window i |
Nomal window
Comment:
Maximized
QOpen File Location Change Icon... Advanced..

@ A software update restores the original shortcut properties.

3.11 Connecting external accessories

The analyzer's standard PC interfaces (Monitor, USB, LAN) can be used to connect
various accessories:

® An external monitor expands/displays the Windows® desktop, which is, by default,
covered by the vector network analyzer (VNA) application window in full-screen
mode.

® External keyboard and mouse simplify local control, in particular manual (GUI)
operation of the VNA application.

® A printer can be used to create hardcopies of the measurement diagrams and
traces from within the VNA application.

® A LAN connection can be established to access the analyzer's mass storage or
control the analyzer from an external PC.

® |nstruments equipped with the latest controller board can also be remote-controlled
via USB.

3.11.1 Connecting a monitor

Connect a standard monitor to one of the monitor connectors on the rear panel of the
instrument.

DisplayPort (recent controller boards only)

HDMI™ (2nd generation R&S ZNB only)

DVI-D (1st generation R&S ZNB only)
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At the graphical user interface of the VNA, activate "System" — "Display" > "View Bar" >
"Hard Key Panel" to add the (virtual) "Hard Key Panel" to the application window.

3.11.2 Connecting a keyboard

A keyboard can be connected to any of the USB connectors. After being auto-detected
by the operating system, it can safely be disconnected and reconnected even during
measurements.

Keyboard configuration

The default input language is English — US. Select "Settings" > "Time & language" >
"Region"/"Language" from the Windows® Start menu to manage languages and key-
boards.

O To access Windows®, use the Bl button in the toolbar of the application window.

3.11.3 Connecting a mouse

A USB mouse can be connected to any of the USB type A connectors. After being
auto-detected by the operating system, it can safely be disconnected and reconnected
even during measurements.

Mouse configuration

Select "Settings" > "Devices" > "Mouse" from the Windows® "Start" menu to configure
the mouse properties.

O To access Windows®, use the Bl button in the toolbar of the application window.

3.11.4 Connecting a printer
A printer can be connected to any of the USB connectors. After successful installation,
it can safely be disconnected and reconnected even during measurements.
Before printing (System — [Print]), the analyzer checks whether a printer is connected
and turned on and whether the appropriate printer driver is installed.
Printer driver installation

If necessary, the printer driver installation is initiated using the operating system's "Add
a printer or scanner". The control is self-explanatory. A printer driver must be installed
only once.
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3.11.5

3.12

Remote operation in a LAN

A great variety of printer drivers are available on the analyzer. To obtain the complete
list, select "Settings" > "Devices" > "Printers & scanners" from the Windows® "Start"
menu.

To access Windows®, use the B button in the toolbar of the application window.

You can load updated and improved driver versions or new drivers from an installation
disk, USB memory stick or another external storage medium. Alternatively, if the ana-
lyzer is integrated in a network, you can install driver data stored in a network directory.
In either case, use the "Add a printer or scanner" control to complete the installation.

Printer configuration

Use the "Printer Setup" dialog of the firmware (System — [Print] > "Print »") or the Win-
dows® printer management to configure the printer properties and printing preferences.

Connecting a USB cable for remote control

Instruments equipped with the latest controller board can also be remote-controlled via
USB. To prepare for remote control operation, connect a suitable USB 2.0 or 3.0 cable
to the type B "USB Device" port on the rear panel of the instrument. With direct con-
nection to a host device, a connecting cable A-B (plug type A onto plug type B) must
be used.

For more information on remote control, refer to the Remote Control section of your
analyzer's help system or user manual.

Remote operation in a LAN

A LAN connection is used to integrate the analyzer into a home/company network.
LAN connectivity offers several applications, e.g.:

® Transfer data between a controller and the analyzer, e.g. to run a remote control
program.

® Control the measurement from a remote computer using Remote Desktop or a sim-
ilar application.

® Use external network devices (e.g. printers).
The analyzer uses a user name and password as credentials for remote access; see

Section 3.9, "Windows operating system", on page 18 for details. To protect the ana-
lyzer from unauthorized access, it is recommended to change the factory setting.
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Remote operation in a LAN

3.12.1 Assigning an IP address

Depending on the network capacities, the TCP/IP address information for the analyzer

can be obtained in different ways.

® |f the network supports dynamic TCP/IP configuration using the Dynamic Host
Configuration Protocol (DHCP), all address information can be assigned automati-
cally.

® |f the network does not support DHCP, or if the analyzer is set to use an alternate
TCP/IP configuration, the addresses must be set manually.

By default, the analyzer is configured to use a dynamic TCP/IP configuration and
obtain all address information automatically. Hence it is safe to establish a physical
connection to the LAN without any previous analyzer configuration.

Manual TCP/IP configuration

If your network does not support DHCP, or if you choose to disable dynamic TCP/IP
configuration, you must assign valid address information before you connect the ana-
lyzer to the LAN. Contact your network administrator to obtain a valid IP address,
because connection errors can affect the entire network.

@ Admin account
You need administrator rights to change the TCP/IP configuration. See Section 3.9,
"Windows operating system", on page 18 for details.

To enter the TCP/IP address information manually

1. Obtain the IP address and subnet mask for the analyzer and the IP address for the
local default gateway from your network administrator. If necessary, also obtain the
name of your DNS domain and the IP addresses of the DNS and WINS servers on
your network.

2. Tap the Windows icon in the toolbar, or press the Windows key in the System key-
pad (or on an external keyboard) to access Windows®.

3. Open the "Control Panel" and select "Network and Internet" > "Network and Shar-
ing Center" > "Change adapter settings" for the Ethernet adapter connection.

4. Pass the Windows user account control, if necessary:

e If your current account is an administrator account, select "Yes".
e |f your account is an account with standard user rights, enter the password of
the administrator account and select "Yes".
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User Account Control X

Do you want to allow this app to make
changes to your device?

I 5- Network Connections

Verified publisher: Microsoft Windows

Show mere details

To continue, enter an admin user name and password.

Admin

More choices

Yes No

Figure 3-1: User Account Control dialog

5. In the "Ethernet Properties" dialog, select "Internet Protocol Version 4 (TCP/IPv4)"
and press "Properties".

6. In the properties dialog, enter the IP address information.

Internet Protocol Version 4 (TCP/IPv4) Properties hat
General

‘You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically

(®) Use the following IP address:

1P address: 192 . 1668 . 1 . 134
subnet mask:
Default gateway: l:l

Obtain DNS server address automatically

(®) Use the following DNS server addresses:

Preferred DNS server: I:l

Alternative DNS server: l:l

[ validate settings upon exit el
Cancel

3.12.2 Using computer names

In a LAN that uses a DNS server (Domain Name System server), each PC or instru-
ment connected in the LAN can be accessed via an unambiguous computer name
instead of the IP address. The DNS server translates the host name to the IP address,
which is especially useful when a DHCP server is used, as a new IP address can be
assigned each time the instrument is restarted.
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Each instrument is delivered with an assigned computer name, but this name can be
changed. The default instrument name is a case-insensitive string with the following
syntax:

ZNB<4|8|20|26]40|43>-<variant>-<serial_number>, ZNB40-N-<serial_number>

The serial number can be found on the rear panel of the instrument. It is the third part
of the device ID printed on the barcode sticker:

& D: 102030

ZNB40-84-102030, for example

Serial Number

3.12.3 Remote Desktop connection

Remote Desktop is a Windows® application that you can use to access and control the
analyzer from a remote computer through a LAN connection. While the measurement
is running, the analyzer screen contents are displayed on the remote computer, and
Remote Desktop provides access to all applications, files, and network resources of
the analyzer.

O At the R&S ZNB, by default remote connections are enabled using a local group policy
= and remote access is granted to users instrument and administrator.

For detailed information about Remote Desktop and the connection, refer to the Win-
dows® Help ("Windows Start Menu" > "Get Help").
To establish a remote desktop connection, proceed as follows:

1. Connect a remote Windows PC and your VNA to the LAN and make sure that an
IP connection can be established.

2. At the remote Windows PC, open a remote desktop connection (type Remote
Desktop Connection at the Windows Start/Search menu and hit enter).

3. Inthe "Remote Desktop Connection" dialog, enter the VNA's computer name or IP
address and select "Connect"
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3124

Remote operation in a LAN

If no external monitor is connected at the time you log in to the instrument via remote
desktop, Windows® possibly displays the following error message:

Microsoft Windows
._@_. Unable to connect to projector

Mo projector was detected.

This message can be safely ignored.

Windows® firewall settings

A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. In the default configuration of the R&S ZNB, the firewall is
enabled. A remote desktop connection does not require any changes in the firewall
settings.

Admin account

You need administrator rights to change the firewall settings. See Section 3.9, "Win-
dows operating system"”, on page 18 for details.

Some actions require a different firewall configuration, e.g.:

® To transfer data with other hosts in the LAN, you have to allow "File and Printer
Sharing".

To change the firewall settings, proceed as follows:

1. Access the operating system by pressing the Windows® key on the external key-
board. Open the "Control Panel".

2. Select "Windows Defender Firewall"

e Select "Allow an app or feature through Windows Defender Firewall" to enable
"File and Printer Sharing".
e Select "Turn Windows Firewall on or off" to enable or disable the firewall.

Confirm the user account control message to allow the desired changes (see Fig-
ure 3-1). For detailed information about the firewall, refer to the Windows® Help.
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4 |nstrument tour

This section gives an overview of the control elements and connectors of the R&S ZNB
and gives all information that is necessary to put the instrument into operation and con-
nect external devices.

The meanings of the labels on the product are described in "Meaning of safety labels"
on page 9.

4.1 Front panel

The front panel of the instrument consists of the touchscreen with the diagrams and
softtool panels (left side), the hardkey area (right side) and the test port area below.
Brief explanations on the controls and connectors, the hardkey area and the rear panel
can be found in the next sections.

& ROHDE&SCHWARZ  (ZNB - Vector Network Analyzer - 100 kHz - 43.5 GHz

f
| Trace
o Q 2 v N
AOQAXAYIREOO DN L T | e
dBMag 15 dB/Ref0dB 1v T2 [B30 dBMag 10 dB/Ref0 dB. er ‘ "~ — =
| ml Line lm-rm}
e

Channel

o T -

Stimulus.

S-Params.
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Wiz

r -10dBm Stop 700MHz [G3l Start 350 MHz Pwr -10dBm Stop 700 MHz

nnel Display Application System Help Ch2: AvgNone  Ch1P1 [B0%

Figure 4-1: R&S ZNB43 with four ports

411 Touchscreen

The analyzer is equipped with a 12.1" diagonal WXGA, 18-bit color LCD touchscreen.
The touchscreen presents all measurement results, mostly in the form of diagrams.
Besides, all instrument functions can be accessed and operated by tapping the control
elements on the touchscreen. For an introduction to touchscreen operation, refer to
Section 5.1, "Manual operation", on page 37.
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The following sections contain further useful information about manual control of the
instrument.

® Refer to the other subsections of Section 5, "Operating the instrument”,
on page 37 to learn how to handle traces and diagrams, and how to use menus,
keys and softtools.

® Refer to section "Concepts and Features" in the user manual or help system to
obtain information about the results in the diagram.

® Refer to section "Display Menu" in the user manual or help system to learn how to
customize the screen.

e Refer to the specifications document for the technical specifications of the display.

O Screen saver
S The screen saver function of the operating system can be used to switch off the display

if the analyzer receives no command for a selectable period of time. The display is
switched on again if any front panel key is pressed.

To enable the screen saver, access the Windows® operating system (e.g. by pressing
the Windows key in the System keypad) and select "Control Panel > Power Options >
Change Plan Settings > Turn off the display".

4.1.2 Function keys

Most of the keys in the Trace, Channel, Stimulus, and System keypads call up a rela-
ted softtool of the analyzer GUI. Every softtool provides access to a group of related
measurement settings.

, Trace The Trace keys give access to all trace settings, to the limit check settings, and to the
wMM) marker functions including marker search.

k The [Meas] settings select the measured and displayed quantity.

® The [Format] settings define how measured data (traces) are presented.
® The [Scale] settings define how traces are scaled.

® The [Trace Config] settings store traces to the memory and perform mathematical
operations on traces.

® The [Line] settings define limits for the measurement results, visualize them in the
diagrams and activate/deactivate the limit check.

® The [Marker] settings position markers on a trace, configure their properties and
select the format of the numerical readout. Markers can also be used to locate spe-
cific points on the trace, define the sweep range, and scale the diagram.

aave — The Channel keys give access to the hardware-related (channel) settings.
]@l) ® The [Pwr Bw Avg] settings define the power of the internal signal source, the IF

béﬁ:?;[] Tvshgﬁh Je, bandwidth, and the sweep average.
® The [Sweep] settings define the scope of measurement, including the sweep type
and the number of measured sweeps.

® [Cal] provides all functions that are necessary to perform a system error correction
(calibration).
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® [Channel Config] provides functions for channel management.
® The [Trigger] settings control the start of the measurement sequence.

e [Offset Embed] provides a selection of length offset parameters to shift the mea-
surement plane.

Stimulus The Stimulus keys ([Start], [Stop], [Center], [Span]) define the sweep range, depending
on the sweep type.

g

Figure 4-2: R&S ZNB system keys (left: 1st gen | right: 2nd gen)

The System keys provide general system settings.

® [File] provides standard Windows® functions used to create, save, recall or print
recall sets, to copy the active screen and to shut down the application.

® The [Print] settings control an external printer that is used to print a hardcopy of the
current recall set.

® [File Print] is available on 2nd generation R&S ZNB only. Gives access to the
[FILE] and [PRINT] settings.

e [DUT] opens a wizard that allows you to set up a measurement by specifying the
properties of the DUT (2nd generation R&S ZNB only)

® [Applic] gives access to external software tools and optional extensions of the ana-
lyzer firmware.

® [Display] gives access to all display settings and to the functions which activate,
modify and arrange different diagrams.

® [Setup] provides general system settings which are not restricted to a particular
recall set.

® The Windows® key opens the startup menu of the Windows® operating system
from where you can perform system configurations and call up additional software
utilities.

® [Help] opens the context-sensitive help system of the analyzer.

® [Preset] performs a preset of the instrument settings.

4.1.3 Data entry keys
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41.4

Front panel

The keys in the data entry keypad are used to enter numbers, units, and characters.
The data entry keys are only enabled while the cursor is placed on a data input field in
a dialog or in the Help navigation pane.

® The keys 0 to 9 enter the corresponding numbers.

® The function of the "." and "-" keys depends on the data type of the active input
field:

— In numeric input fields, the keys enter the decimal point and a negative sign for
the entered numeric value. Multiple entries have not effect.

— In character input fields, the keys enter a dot and a hyphen, respectively. Both
entries can be repeated as often as desired.

® The function of the four unit keys depends on the data type of the active input field;
see Section 5.6, "Entering data", on page 54.

— In numeric input fields, the [G/n] and [M/u], keys multiply the entered value with
factors of 10%%, 10%6, 10%3, respectively, and add the appropriate physical unit.

— In character input fields, the [G/n], [M/u], [k/m] keys enter the letters G, M, K,
respectively.
[x1]is equivalent to [<] (Enter) and confirms the previous entry.

® [Esc]is used to:

— Cancel entries / close dialogs without activating the entries made (equivalent to
the "Close" button).

— Close the help system.
e [<] (Enter)is used to:

— Activate the selected active control element, e.g. a button in a dialog or a link in
the "Contents" page of the Help system.

— Confirm selections and entries made and close dialogs.
Same functionality as the [OK] button in the navigation area.

— Compress or expand menus or the help system's table of contents

® [—] (Backspace) deletes the last character before the cursor position or the
selected character sequence or numeric value.

Rotary knob

The rotary knob increases and decreases numerical values, scrolls within lists, acti-
vates controls and confirms entries.

® Turning the rotary knob to the left or right is equivalent to pressing the [{] (up) or
[8] (down) navigation key multiple times.

® Pressing the rotary knob is equivalent to pressing the [—] (Enter) data entry key or
the [OK] navigation key.

[Step Size] opens an input box to select the steps (in units of the current physical
parameter) between two consecutive numerical values. The step size is also valid for
value changes using the [©] (up) and [8] (down) keys. See also Section 5.6.2, "Using
the numeric editor”, on page 55.
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4.1.5 Navigation keys

Use the keys in the navigation keypad to navigate within the analyzer GUI and help
system.

With [©] (up) and [{] (down) you can:

® Scroll up and down in lists, e.g. among menu items, in a list of keywords, or in the
help system's table of contents or index
[©] (up) becomes inactive as soon as the beginning of the list is reached. [¥]
(down) becomes inactive as soon as the end of the list is reached.

® Navigate between table rows in diagrams
Then press [OK] to toggle between navigation and data entry mode.

® |ncrease and decrease numerical input values

Instead of pressing [1] (up) or [¥] (down) you can also turn the rotary knob to the right
or left, respectively.

The [«=] (left) and [=] (right) keys are used to:

® Move the cursor to the left or right within input fields

® Navigate between table columns in diagrams.
(Then press [OK] to toggle between navigation and data entry mode.)

® Compress or expand menus or the help system's table of contents
® Move the highlighted item in the menu bar of the active application

[OK] is equivalent to pressing the rotary knob or the [<] (Enter) key in the data entry
keypad.

[Undo] reverses the last action, if possible. [Redo] reverses the action of the [Undo]
button.
4.1.6 Standby key

I=x=1 The standby toggle switch is located in the bottom-left corner of the front panel.

| V] | The key serves two main purposes:

® Toggle between standby and ready state; see Section 3.8, "Standby and ready
state", on page 18.

® Shut down the instrument; see Section 3.7, "Switching the instrument on and off",
on page 17.

4.1.7 Front panel connectors

The test ports and four USB connectors are located on the front panel of the R&S ZNB.

41.71 Test ports
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Numbered connectors:

® Type N female for R&S ZNB4 and R&S ZNB8
® 3.5 mm male for R&S ZNB20

e 2.92 mm (K) male for other R&S ZNB models

The test ports serve as outputs for the RF stimulus signal and as inputs for the mea-
sured RF signals from the DUT (response signals).

® With a single test port, it is possible to generate a stimulus signal and measure the
response signal in reflection. For a measurement example, refer to Section 6.2,
"Reflection S-parameter measurement", on page 70.

® With more than one test port, it is possible to perform full two-port, 3-port, ..., or n-
port measurements; see Section 6.1, "Transmission S-parameter measurement”,
on page 64.
In the standard configuration, all test ports are supplied by a common source.
Four-port instruments are available with an optional second source.

@ ® Use a torque wrench when screwing RF cables on the test port connectors.
® See also Section 3.5, "Considerations for test setup”, on page 16.

41.7.2 USB connectors
Four high-speed Universal Serial Bus connectors of type A.

The USB ports can be used to connect:

® External PC accessories such as mouse or other pointing devices, a keyboard,
printer or external storage device (USB flash drive, CD-ROM drive etc.).

® External measurement equipment such as calibration units, power meters, signal
generators or switch matrices.

4.2 Rear panel

This section gives an overview of the rear panel controls and connectors of the net-
work analyzer.
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Rear panel

Figure 4-3: R&S ZNB rear view

top = 1st generation R&S ZNB (with latest CPU board LPW11)
bottom = 2nd generation R&S ZNB (order nos. 1334.3330.xx)
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Rear panel
Table 4-1: Rear panel connectors available on all instruments
Index | Label Description
1 (Power Power on / off switch, see Section 3.7, "Switching the instrument on and off",
1/0) on page 17
2 LAN RJ-45 connector to integrate the instrument to a Local Area Network, primarily for
remote control purposes. See Section 3.12, "Remote operation in a LAN",
on page 23.
3 USB/ Two additional type A USB 3.0 host connectors; similar functionality as the USB con-
USB Host | nectors on the front panel (see Section 4.1.7.2, "USB connectors", on page 33).
4 Display External monitor connector (DisplayPort); see Section 3.11.1, "Connecting a moni-
Port tor", on page 21.

(n.a. for 1st gen R&S ZNB with CPU board before LPW11)

5 USB Type B USB 3.0 device connector for remote control of the instrument (see Sec-
Device tion 3.11.5, "Connecting a USB cable for remote control", on page 23)
6 Monitor External monitor connector

e DVI-D for 1st generation R&S ZNB
®  HDMI™ for 2nd generation R&S ZNB

See Section 3.11.1, "Connecting a monitor", on page 21.

7 USER 25-pin D-Sub connector used as an input and output for low-voltage (3.3 V) TTL
PORT control signals

8 Trigger Two BNC connectors for 5 V TTL external trigger signals
Out, Trig-
ger In

9 REF OUT | BNC output for the internal reference frequency of the analyzer. Use this connector

to synchronize other instruments to the analyzer.

10 REF IN BNC input for an external reference frequency. Use this connector to synchronize
the analyzer to another device.

11 SYSTEM | Contains the removable system drive of the instrument, containing all software
DRIVE (including the operating system and the VNA application) and data. Do not remove
the system drive during operation.

Option R&S ZNB-B19 provides an additional removable system drive (including
operating system and firmware).

12 (Ground The ground connector provides the ground of the analyzer's supply voltage. Use this
connector) | connector for ESD protection; see "Preventing electrostatic discharge (ESD)"
on page 16.
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Table 4-2: Optional rear panel connectors
Index | Label Description
13 Bias Tees | Two or four additional BNC inputs labeled PORT BIAS 1 ... 4 (for two-port or four-

port analyzers). The inputs can be used to apply external DC voltages (biases) to

the test ports.

® Not available for 2nd generation R&S ZNB20 and for 1st generation
R&S ZNB40 that are equipped with the new reflectometer board (order no.
1317.8015.03)

®  Optional for R&S ZNB4|8

e  Always equipped for other R&S ZNB models

® "Bias Tees", providing two or four additional BNC inputs labeled PORT BIAS
1 ... 4 (for two-port or four-port analyzers). The inputs can be used to apply
external DC voltages (biases) to the test ports.

Note that there is no additional HW or SW switch for the bias tees, i.e. the voltage is
applied to the RF port as soon as you connect the voltage source to the correspond-
ing PORT BIAS connector.

For fuse replacement, see the corresponing section in the maintenance chapter of
the user manual.

13 or R&S ZN-B15 "RFFE - GPIO Interface" (1st generation R&S ZNB only)
25-pin female connector, providing:

int |
gFeFrréa- ® 2 independent RF Front-End (RFFE) interfaces according to the MIPI® Alliance
GPIO "System Power Management Interface Specification”.
N :
Interface 10 General Purpose Input/Output (GPIO) pins.
14 Device Option R&S ZNB-B12 "Device Control" provides a PCle and a Direct Control con-
Control nector.
The Direct Control interface enables direct connections between the VNA measure-
ment bus and one or more extension devices, such as:
®  An external RFFE GPIO interface R&S ZN-Z15.
®  Switch matrices R&S ZN-Z8x.
15 HAN- Option R&S ZN-B14, Handler 1/O (Universal Interface), providing a Centronics 36
DLER IO | input/output connector.
16 GPIB Option R&S ZNB-B10 provides a GPIB bus connector according to standard IEEE
488/ IEC 625.
17 DC INPUT | Option R&S ZNB-B81 "DC Inputs" provides four BNC inputs for DC measurements

(adjustable to different voltage ranges).

Match signals with 50 Q to comply with EMC directives. See also Section 3.5, "Consid-
erations for test setup"”, on page 16.
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5 Operating the instrument

5.1

The following sections describe the basics of manual operation, i.e. how to access
instrument functions and settings via the analyzer GUI. Manual operation is particularly
useful for getting to know the instrument and for trouble shooting.

Manual and remote control of the instrument

Manual control of the R&S ZNB is possible either via its touchscreen and front panel
keys, via locally connected keyboard and mouse (see Section 3.11, "Connecting exter-
nal accessories", on page 21), or via Remote Desktop (see also Section 3.12, "Remote
operation in a LAN", on page 23).

Alternatively, it can be remote-controlled via USB (latest controller board only), GPIB or
LAN.

To their full extent, manual operation and remote control are described in the GUI Ref-
erence and Command Reference sections of the User Manual, respectively. GUI func-
tions and related remote commands are linked bidirectionally. Background information
is provided in the Concepts and Features section of the User Manual.

Manual operation

The analyzer functions are accessible via several tabbed softtools, each presenting
related functions and settings. See Section 5.2.4, "Softtools", on page 44.

The function keys on the front panel or the on-screen "Hard Key Panel" open the most
frequently used softtools.

Manual operation via function keys and softtools provides touch-friendly access to the
instrument functions and settings, avoiding complicated menu structures and long
operating sequences. In general, this approach is recommended. However, sometimes
the toolbar or an object's context menu can offer a shortcut. The menu bar provides
access to all instrument functions and settings.
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Figure 5-1: Function Keys

Using the front panel

To access an instrument function:

1. Press a (virtual) key, e.g. the [Meas] key in the Trace section.

The corresponding softtool expands at the current docking position.

Measurement Menu =
5-Parameters
5
Params

Ratios
Wave

All Z € Sij
5-Params
*+ S-Param > Y € 5ij
* N Wizard
Balanced Ports ‘I-_ Z_- _
_ Params
]

Stability

Power
Sensor

DC

2. From the "Measurement Menu", select "S-Parameters".

3. Activate the desired softtool tab, e.g. "ZSij".
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Measurement Menu

_ v
5-Parameters

Balanced Ports
[ mmr M|
L »
[T

4. Select a control element, e.g. "Z—S11".

The diagram immediately reflects your selection. The active trace shows the mea-
surement results for the selected measured quantity.

Using the menu bar

The menu bar at the bottom of the application screen provides alternative access to all
instrument functions. To repeat the measured quantity selection described above,

» Select "Trace" — "Meas" > "S-Parameters" > "Z«Sij" > "ZS11".
File 'Trace Channel Display Tools System Help

Meas b Balanced Ports

Format 4 S-Parameters 5 Params

Scale 4 Mixer Measurements Ratios

Trace Config ¥ Intermodulation Wave

Lines 4 Noise Figure 7 & Sif
Marker 4 Time Domain
Extended Time Domain » Y- Z- Params

Signal Integrity Apps P Imbalance CMRR »

External DLLs ¥ Stability 4

Power Sensor B

DC »

The diagram immediately reflects your selection. The active trace shows the mea-
surement results for the selected measured quantity. At the same time, the related
softtool tab is opened.
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Using context menus

Context menus are another alternative for quick access to instrument settings.

1. Touch and hold (right-click) the measured quantity section in the trace info for a
couple of seconds until the context menu appears.

51
512
521
522

S5-Parameter

b1fa1 Src Port 1
b2/a1 Src Port 1
¥ More Ratios

a'l Src Port 1
b1 Sre Port 1
b2 Src Port 1
a2 Src Port 2
¥ More Wave Quantities
Color Scheme...

Define User Color

2. Select "S-Parameter" to open the "S-Params" softtool tab.

Measurement Menu =
5-Parameters
5
Params

All
5-Params

*+ 5-Param
* N Wizard

Balanced Ports
[P m oM
L »
[T

3. Select "S11".

5.2 Control elements of the application window

The application window of the analyzer GUI provides all control elements for the mea-
surements and contains the diagrams for the results.
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There are several alternative ways for accessing an instrument function:

® Using a function key on the (virtual) hardkey panel to open the related softtool (rec-
ommended, provides all settings)

® Using the menus and submenus of the menu bar (an alternative to the previous
method)

® Using the context menus of certain display objects (for important actions in the
context of this object)

® Using the icons in the toolbar above the diagram area (for frequent global actions)

These methods are described in more detail in the following sections.

O Customizing the screen

The contents of the screen and the size and position of many display and control ele-
ments are not fixed. You can display or hide most elements. You can also drag and
drop traces, info fields, and even the softtool panel to your preferred position; see Sec-
tion 5.5.4, "Using drag and drop", on page 53.

5.2.1 Title bar

By default, the analyzer GUI is shown in full-screen mode, covering the whole screen
and hiding the Windows taskbar. However, you can toggle the full-screen mode using
System — [Display] > "View Bar" > "Title and Task Bar On".
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If full-screen mode is switched off, the main application window of the vector network
analyzer application provides a standard Windows® title bar.

[ Vector Network Analyzer - Rohde & Schwarz VNA = [m} *

5.2.2 Toolbar

The toolbar above the diagram area contains the most frequently used control ele-
ments of the user interface. All controls are also accessible via Softtools.

The toolbar is divided into several icon groups, separated by vertical lines.

These icons represent the undo and redo actions that are also available
via the menu bar items "System" > "Undo" / "Redo".

Undo reverses the last action, redo reverses the last undo action (if possi-
ble).

These icons control the zoom function (Trace — [Scale] > "Zoom").

If multiple diagrams are configured, this icon toggles the "Maximize Dia-
gram" action for the active diagram (System — [Display] > "Diagram" >
"Maximize Diagram").

These icons implement the following actions, from left to right:
® Add a clone of the active trace to the active diagram (single tap; same
as Trace — [Trace Config] > "Traces" > "Add Trace") or to an

arbitrary/new one (drag & drop the B icon to the diagram area).
® Add a new marker to the active diagram (single tap; similar to Trace —
[Marker] > "Markers" > "Mkr<i>") or to an arbitrary one (drag & drop
the "Mkr+" icon).
® Delete:
—  The active trace by tapping/clicking the trash icon
— An arbitrary trace by dragging and dropping its trace info field on
the trash icon
—  All markers of a trace by dragging and dropping the trace's
marker info field on the trash icon
— Asingle marker by dragging and dropping the marker symbol on
the trash icon

These icons provide some helper functions. From left to right:

B == ® Save the current diagrams as a BMP, JPEG, PNG, SVG, or PDF file.
®  Open the Windows Start menu.
“ Restart the sweep in all channels.
= Same as Channel — [Sweep] > "Sweep Control" > "Restart Sweep"
~ These icons provide the following actions:
E :;1"_ . ® Toggle advanced diagram area editing, which makes rearranging

and/or deleting diagrams a breeze.
®  Toggle other measurements (except the active trace) OFF|ON
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Uncertainty Analysis™ is installed. It is only enabled if a METAS calibration
is active.

Open the "METAS Reconnection" dialog
This button is only visible if, option R&S ZNB-K50(P) "Measurement
n Open the SCPI recorder

O You can toggle the visibility of the toolbar using System — [Display] > "View Bar" > "Tool
= Bar".

5.2.3 Hardkey panel

The (virtual) "Hard Key" panel provides on-screen access to the function keys of the
R&S ZNB. Most of the function keys open a related softtool. For a short description,
refer to section Section 4.1.2, "Function keys", on page 29.

Format

Trace

Config
Line Marker
Stimulus

Start

Center

Channel
Power

Bw Avg

Cal

Trigger
System

File

Print =

Tools Display

Preset

O The (virtual) "Hard Key" panel is particularly useful if the analyzer is controlled from an
= external monitor or Remote Desktop. It is hidden by default.

You can display the "Hard Key" panel using one of the following methods:

® Select System — [Display] > "View Bar" > "Hard Key Panel".

® Select "Display"> "View Bar" > "Hard Key Panel On" from the menu bar.
® Select "Hard Key" from the context menu of the softtool panel.
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5.2.4 Softtools

Softtools display groups of related settings as a tabbed panel with a collapse/expand
toggle EIKL. They can be opened via function keys on the front panel or the on-screen
"Hard Key" panel, or via menu bar and context menu items.

Show Limit Limit

" line Test

Limit Ripple
Check Test

Clear Circle
Test Test
Define Display
Limit Line: Circle

Global Check Horiz.
Off

Line

TIL1 Pass

TTL2 Pass

Shift Lines

Stimulus

Response

Figure 5-2: Lines softtool
Some controls on the softtool tabs allow you to read and modify settings (e.g. "Stimu-

lus" in the screenshot above), some perform actions (e.g. "Show Limit Line"), while but-
tons with a @ symbol open additional dialogs (e.g. "Define Limit Line").

O Use the context menu of the softtool panel to configure its position (right/left).

5.2.5 Menu bar

You can also access the analyzer functions via textual menus. The menu bar is located
below the diagram area:

File Trace Channel Display Tools System Help

As in any Windows® application, menus can be controlled with the touchscreen or a
mouse. A short tap (left mouse click) expands a menu or submenu. If a menu com-
mand has no submenu assigned, a short tap (left mouse click) opens a dialog, or
directly activates the menu command. When a menu item is selected, the R&S ZNB
displays the corresponding softtool.

Overview of menu functions

® The "File" menu provides functions to handle recall sets and trace files, to print or
save diagram content, and to shut down the VNA application.

® The "Trace" menu provides all trace settings, the limit check settings, and the
marker functions including marker search.
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® The "Channel" menu provides all channel settings and activates, modifies or stores
different channels.

® The "Display" menu provides all display settings and the functions for activating,
modifying and arranging different diagrams.

® The "Tools" menu gives access to tools that extend the functionality of the analyzer
firmware.

® The "System" menu provides functions that can be used to return to a defined
instrument state, reverse operations, access service functions and define various
system-related settings.

® The "Help" menu aids with the network analyzer and its operation.

O You can configure the position of the menu bar (top/bottom) from the context menu of
= the softtool or hardkey panel. Furthermore, you can toggle its visibility using System —
[Display] > "View Bar" > "Menu Bar".

5.2.6 Status bar

The status bar shows:
® The active channel

® The current channel's sweep averaging counter (e.g. "Ch<i>: Avg 9/10"), or "Ch<i>:
Avg None" if averaging is disabled.

® The progress of the sweep
The progress bar also shows when the R&S ZNB prepares a sweep with new
channel settings.

® The "EXT REF" symbol, if an external reference clock is used for synchronization.
® A symbol for redefined S-parameters, if the physical ports have been redefined.

® The switch matrix status symbol, if a switch matrix is configured.
(See the R&S ZNB User Manual)

® The current date and time

Ch1: Avg None 7/17/2024 11:29:33 AM

The progress bar shows a moving color gradient if the current sweep is too fast to be
monitored, e.g. because the number of sweep points is low.

Additional icons in the status bar indicate a non-standard hardware setup.

Table 5-1: Additional status bar information

Icon Description

EXT m.-_:a External reference clock
Redefined physical ports
Switch matrix
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O You can configure the position of the status bar (top/bottom) from the context menu of
= the softtool or hardkey panel. Furthermore, you can toggle its visibility using System —
[Display] > "View Bar" > "Status Bar".

5.3 Touchscreen gestures

Instruments of the 2nd generation (order nos 1334.3330.xx) are equipped with capaci-
tive screens, which allow for multi-touch gestures.

A touchscreen allows you to interact with the software using various finger gestures on
the screen. The basic gestures supported by the software and most applications are
described here. Further actions using the same gestures may be possible.

Tapping
Touch the screen quickly, usually on a specific element.

You can tap most elements on the screen; in particular, any elements you can also
click on with a mouse pointer.

Figure 5-3: Tapping

Double-tapping
Tap the screen twice, in quick succession.

Double-tap a diagram to maximize it or to restore its original size.

Dragging
Move your finger from one position to another on the display, keeping your finger on

the display the whole time.

@ @ By dragging your finger over a table or diagram you can pan the displayed area of the

table or diagram to show results that were previously out of view.
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Figure 5-4: Dragging

Spreading and pinching two fingers

Move two fingers apart on the display (spread) or move two fingers together on the dis-
play (pinch).

These gestures take effect for diagrams only. The effect depends on the current zoom
mode (see Section 5.7, "Scaling diagrams", on page 57).

N/
& O

® |n graphical zoom mode, when you spread two fingers in the display, you graphi-
cally zoom in vertically.

Figure 5-5: Pinching

While "Zoom Select" is active (toolbar icon or softtool button is toggled on), spread-
ing and pinching is disabled. You can only select a rectangular area (using one fin-
ger) then.

® |n stimulus zoom mode, spreading and pinging is disabled by default. Only while
"Stim. Zoom Select" is active (toolbar icon or softtool button is toggled on), you can
use spreading and pinching to modify the sweep area and/or the vertical scaling.
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Working with dialogs

Mouse vs. touch actions

Any user interface elements that react to actions by a mouse pointer also react to fin-
ger gestures on the screen, and vice versa. The following touch actions correspond to
mouse actions:

Table 5-2: Correlation of mouse and touch actions

Mouse operation Touch operation

Click Tap

Double-click Double-tap

Click and hold Touch and hold

Right-click Touch, hold for 1 second and release

Drag&drop (= click and hold, then drag and release) | Touch, then drag and release

n.a. (Change hardware settings) Spread and pinch two fingers

Mouse wheel to scroll up or down Swipe

Dragging scrollbars to scroll up or down, left or right | Swipe

In (graphical) zoom mode only: dragging the borders | Touch, then drag and release
of the displayed rectangle to change its size

Example:

You can scroll through a long table in conventional mouse operation by clicking in the
table's scrollbar repeatedly. In touchscreen operation, you can scroll through the table
by dragging the table up and down with your finger.

Working with dialogs

Dialogs provide groups of related settings and allow you to make selections and enter
data in an organized way. The settings are visualized, if possible. An example is shown
below.
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Balanced Ports
Predefined Config User Config  Reference Impedance

Select Predefined Ports
Physical Ports
P
L ]
11 L2 L L1
{A) 2 x Single (B) 1 x Balanced (C) 1 x Single

P1

© ©

Logical Ports

All dialogs are operated in a similar way.
® The title bar of each dialog contains some convenience functions:

— Use the "Opacity" function to let the display elements behind the dialog shine
through.

L]
Opacity

Note: This is a global setting, i.e. it applies to all dialogs.

— The Eicon creates a screenshot of the dialog.

— The [@ button opens the help system, which provides context-sensitive informa-
tion on the dialog's settings.

® Drag and drop the lower right corner of the dialog to modify its size.

® Some dialogs are subdivided into tabs, containing groups of related settings. Acti-
vate a tab to access those settings.

5.5 Handling diagrams, traces, and markers

The analyzer displays measurement results as traces in rectangular diagrams. Markers
are used to read specific numerical values and to search for points or regions on a
trace. The following section presents some of the graphical tools the R&S ZNB pro-
vides for trace and marker handling.
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O For further reference

Refer to section "Concepts and Features" in the R&S ZNB Help or in the User Manual
to learn more about traces, channels, and screen elements.

5.5.1 Adding traces and diagrams

A new trace is required if you want to measure and display an additional quantity.

Typical scenario: The transmission coefficient S,; is measured as described in Sec-
tion 6.1, "Transmission S-parameter measurement", on page 64. A trace is added to
display the reflection coefficient S,; for comparison.

To create a trace:
1. Drag the @ icon from the toolbar into a diagram.

The diagram changes its color scheme and contents as shown below.

Trc1 [BXH dBMag 10dB/ Ref 0 dB

Chl Start 100 kHz Pwr -10dBm Bw 10kHz Stop 20 GHz

2. Select the adequate drop position, depending on whether you want to display the
new trace in the existing diagram, or whether you want to add a new diagram. The
highlighted area indicates the target diagram.
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1 [BXl dB Mag 10 dB/Ref 0 dB

. Split horizontally,
) s g B add frace above [N

Split vertically, Add frace in Split vertically,
add trace to the existing diagram add trace to the
left right
Split horizontally,
add trace below

Start 100 kHz Pwr -10dBm Stop 8.5 GHix

3. Inthe dialog box that opens when you release the "New Trace" icon, select the S-
parameter to be measured.
For a four-port analyzer:

New Trace = @ ® M X

Select S-Parameter for the new trace

511 512 513

The R&S ZNB generates a new trace for the selected S-parameter.

O Alternative control elements

You can also drag and drop a softkey representing a measured quantity to create a
trace. Or simply select another softkey to change the measured quantity of the active
trace.

Select Trace — [Trace Config] to access more trace handling functions. Select System
— [Display] to access more diagram handling functions.

5.5.2 Adding markers

A marker is needed, for instance, to read a particular numerical trace value.
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To add a new marker:

® Drag and drop the i icon from the toolbar to the desired position in the target dia-
gram.

dB Mag 10 dB/ Re

M2
A 4

Chll Start 100 kHz Pwr -10dBm Bw 10kHz

The marker appears on the target diagram's active trace. The marker info field dis-
plays the stimulus value (x-axis value) and response value (y-axis value) at the
marker position. The response value varies as the analyzer continues performing
sweeps.

O Active trace, alternative control elements

The trace line of the active trace in the upper part of the diagram is highlighted. If the
diagram contains several traces, first activate the target trace, then add the marker.
The Trace — [Marker] softtool provides more functions for marker handling. In particu-
lar, any marker offered in the "Markers" tab can be positioned on the active trace using
drag & drop.

5.5.3 Deleting display elements

8 Markers, traces, diagrams, and other display elements are most conveniently deleted
using the "Delete" icon in the toolbar above the diagram area.

® To delete a single marker, drag it in vertical direction to release it from the trace
and drop it onto the "Delete" icon.
To delete a set of markers, drag and drop their marker info field onto the "Delete"
icon.
Deleting a marker and its info field also disables the associated marker function.

® To delete a trace, drag and drop its trace line onto the "Delete" icon. The active
trace can also be deleted by tapping/clicking the "Delete" icon.
Note however, that the last remaining trace cannot be deleted.

® To delete a diagram, drag and drop its dropdown handle kdl onto the "Delete" icon.
Note however, that the last remaining diagram cannot be deleted.

® To delete a channel, drag and drop all associated traces onto the "Delete" icon.
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Note however, that the last remaining channel cannot be deleted.

® To hide the limit lines and disable the limit check, drag and drop the PASS / FAIL
message onto the "Delete" icon. The limit line itself is not deleted and can be
reused.

The context menu of some display elements also provides the "Delete" function.

O Undo function

If you happen to delete a display element unintentionally, you can restore it using the
"Undo" toolbar icon.

5.5.4 Using drag and drop

You can drag and drop many of the R&S ZNB's control and display elements to change
their size and position. The drag and drop functionality is often more convenient to use
than the equivalent buttons of the softtool panels. The following table gives an over-
view.

Table 5-3: Drag and drop functionality for various screen elements

Screen element Action Drag and drop...

Diagram Create See Section 5.5.1, "Adding traces and diagrams", on page 50
Resize Separator between adjacent diagrams
Delete See Section 5.5.3, "Deleting display elements", on page 52

Trace Create See Section 5.5.1, "Adding traces and diagrams", on page 50
Move vertically Reference line marker (right diagram edge)

Move into other or new | Trace line

diagram
Delete See Section 5.5.3, "Deleting display elements", on page 52
Reset / suspend "Zoom" element in additional trace line --> "Delete" icon; see Section 5.7.1,
graphic zoom "Using the graphical zoom", on page 57
Marker Create See Section 5.5.2, "Adding markers", on page 51
Move horizontally Marker symbol
Delete Marker or marker info field --> "Delete" icon; see Section 5.5.3, "Deleting display
elements”, on page 52
Marker info field Add See Section 5.5.2, "Adding markers", on page 51

Move within diagram Marker info field (move to one of several predefined positions)

Delete See Section 5.5.3, "Deleting display elements", on page 52
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5.6 Entering data

The analyzer provides dialogs with various types of input fields where you can enter
numeric values and character data. Data entry with a mouse and an external keyboard
is a standard procedure known from other Windows® applications. However, there are
various other ways to enter data.

5.6.1 Using front panel keys

You can use the keys in the data entry keypad to enter numbers, units, and characters.

To enter a numeric value:
1. Select a numeric data input field to activate it.

2. Press the data entry keys.

Use [0] to [9] to enter the corresponding numbers.

Use [.] to enter a decimal point.

Use [-] to change the sign of the value.

Use [G/n], [M/u], [k/m], or [x1] to multiply the entered value with factors of 10)°,
1008, 1063 or 1 and to add the appropriate physical unit.

To enter a character string:
1. Tap a character data input field to activate it.

2. Press the data entry keys as if you were writing a short message on your mobile
phone.

e Use [0] to [9] to enter the corresponding numbers.

e Use [.] and [-] to enter a dot or hyphen.

e Use [G/n], [M/u], or [k/m] to enter the letters G, M or K (case-insensitive).

e Use the B (backspace) key to correct wrong entries, deleting the character to
the left of the current cursor position.
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e Press [<] (Enter) to complete an entry.
e Press [Esc] to discard the entries made.

3. To enter letters other than G, n, M, y, K or m you can also use one of the methods
described in the following sections:

e Section 5.6.3, "Using the analyzer's on-screen keyboard", on page 56
e Section 5.6.4, "Using the Windows® on-screen keyboard", on page 56

5.6.2 Using the numeric editor

The "Numeric Editor" is a tool for convenient entry and modification of numeric values.
It is available for all numeric input fields in the analyzer GUI.

Operation with touchscreen or mouse:

1. Double-tap (double-click) a numeric input field in a dialog or on a softtool to open
the numeric editor.

Start Frequency

9 kH
Min: 9 kHz Max: 8.5 GHz

D « &

MAXA@
MN ¥ =

4 P

2. Use the buttons in the numeric keypad to enter a value.
3. Add a unit (buttons"Hz", ..., "GHz")

4. Use the up/down buttons to increment/decrement the value by the current "Step
Size".

5. Use the menu button to expand the dialog:

This unhides the functions to set the "Step Size" and the "Set to Marker" function.
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The latter is enabled if the active trace has markers with a suitable stimulus or
response unit.

6. After completing the input, select « to apply the new value and close the editor.

5.6.3 Using the analyzer's on-screen keyboard

The on-screen "Keyboard" allows you to enter characters, in particular letters, without
an external keyboard. It is available for all text input fields in the analyzer GUI.

1. Activate a character data input field in a softtool or a dialog.

2.
3.
4.

Double-tap/click the input field to open the on-screen keyboard.
Select character buttons to compose the input string.

Select "Enter" to apply your selection and close the keyboard.

5.6.4 Using the Windows® on-screen keyboard
The Windows® on-screen keyboard allows you to enter characters, in particular letters,

even if an input field cannot call up the analyzer's own on-screen keyboard. Examples
are input fields in standard Windows © dialogs.
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Home PgUp
End PgDn
Enter Insert Pause

Shift Prtscn Scrik

Alt < > Options  Help

Figure 5-6: Windows on-screen keyboard

To call up the on-screen keyboard:
1. Open the System — [Applic] softtool.

2. Select "External Tools" > "Screen Keyboard".

5.7 Scaling diagrams

The analyzer provides various tools for customizing the diagrams and for setting the
sweep range. Choose the method that is most convenient for you.

5.7.1 Using the graphical zoom

The graphical zoom function magnifies a rectangular portion of the diagram (zoom win-
dow) to fill the entire diagram area. The sweep points are not affected.

O The graphical zoom function is only supported for cartesian trace formats. For (inver-
= ted) Smith and polar diagrams, it is not available.

To activate the graphical zoom:

® Select the "Zoom Config" icon in the toolbar above the diagram area and make
sure that the graphical zoom mode is active:

v Mode Graphical Zoom

Mode Stimulus Zoom

= Open Zoom Soft Tool

® Select the "Zoom Select" toggle button in the toolbar above the diagram area.
The icon changes its background color from black to blue.
® |n the active diagram area, select an appropriate rectangular area.
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The zoomed view shows the selected rectangle, scaled in both horizontal and verti-
cal direction. In general, the zoom window covers only a part of the sweep range;
the horizontal distance between the sweep points increases. The reduced display

range is indicated in an additional zoom line in the channel info area.
Chl| Start 1GHz - Pwr -10 dBm Stop 6 GHz

Start 3.02 GHz Zoom Trcl Stop 5.96 GHz

Use the "Zoom Reset" icon to restore the original diagram. Alternatively, you can drag

and drop the "Zoom" label from the additional channel info line onto the kil toolbar but-
ton.
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O Alternative settings

® The Trace — [Scale] > "Zoom" softtool tab allows you to define the displayed zoom
range numerically.
It can also be opened from the menu of the "Zoom Config" toolbar icon.

® |f the active diagram is graphically zoomed, "Overview On" in the "Zoom" softtool
tab toggles an overview. The upper part of the diagram then shows a small version
of the unzoomed diagram. You can move the zoomed part of the trace by moving
the rectangular area in the overview.

Start 4.51GHz — == Zoom Trc3TrcdTre5 3.2 dB/ Stop  5.53 GHz

® To zoom the stimulus range (keeping the number of sweep points constant), use
the "Zoom Config" toolbar icon and select "Mode Stimulus Zoom". Then use the
"Zoom Select" icon to narrow the sweep range and adjust the vertical scaling.

Refer to the R&S ZNB Help or User Manual for details.

5.7.2 Setting the sweep range

The sweep range for all related channels is displayed in the channel info area at the
bottom of each diagram:

To change the sweep range of the active channel, use one of the following methods:

® Use the [Start], [Stop], [Center], and [Span] function keys from the Stimulus sec-
tion.

® Double-tap (with a mouse: double-click) the "Start" or "Stop" label in the channel
list.
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® Tap and hold (with a mouse: right-click) the "Start" or "Stop" label in the channel list
and select "Start Frequency", "Stop Frequency", "Center Frequency", or "Fre-
quency Span" from the context menu.

® Select "Start Frequency", "Stop Frequency", "Center Frequency", "Span Fre-
quency" from the "Channel" > "Stimulus" menu.

® Use the "Set by Marker" functions (Trace — [Marker] > "Set by Marker"; see Sec-
tion 5.7.6, "Set by marker", on page 61).

5.7.3 Reference value and position

The analyzer provides three parameters for changing the scale of the vertical
(response) axis:

® Changing the "Ref Value" or "Ref Pos" shifts the trace in a vertical direction and
adjusts the labels of the vertical axis. "Ref Value" also works for radial diagrams.

® Changing the "Scale/Div" modifies the value of the vertical or radial diagram divi-
sions and thus the entire range of response values displayed.

The "Scale/Div" and the "Ref Value" are indicated in the scale section of the trace info.
In the example below, a "Scale/Div" of 10 dB and a "Ref Value" of 0 dB is used.

Trcl |55 dBMag 10 dB/Ref0dB Math

To change such a scale parameter, use one of the following methods:
® Open the Trace — [Scale] > "Scale Values" softtool tab and proceed from there.

® Tap and hold (with a mouse: right-click) the scale section in the trace info and
select a setting from the context menu.

® Select a setting from the "Trace" > "Scale" menu.

® Use "Set by Marker" functions (Trace — [Marker] > "Set by Marker"; see Sec-
tion 5.7.6, "Set by marker", on page 61).

5.7.4 Auto scale

The "Auto Scale" function adjusts the scale divisions and the reference value so that
the entire trace fits into the diagram. To access "Auto Scale", use one of the following
methods:

® Open the Trace — [Scale] > "Scale Values" softtool tab and select "Auto Scale
Trace" or "Auto Scale Diagram".

® Tap and hold (with a mouse: right-click) the scale section in the trace info and
select "Auto Scale Trace" from the context menu.

® Select "Auto Scale Trace" or "Auto Scale Diagram" from the "Trace" > "Scale"
menu.
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5.7.5

5.7.6

Scaling diagrams

Circular diagrams

The radial scale of a circular diagram ("Polar", "Smith" or "Inverted Smith") can be
changed with a single linear parameter, the "Ref Value". The reference value defines
the radius of the outer circumference.

® Increasing the "Ref Value" scales down the polar diagram.
® Decreasing the "Ref Value" magnifies the polar diagram.

The "Ref Value" is indicated in the scale section of the trace info.

To change the "Ref Value" setting, use one of the following methods:
® |[ocate it on the Trace — [Scale] > "Scale Values" softtool tab.

® Tap and hold (with a mouse: right-click) the scale section in the trace info and
select the parameter from the context menu.

® Select the parameter from the "Trace" > "Scale" menu.

® Use the "Set by Marker" functions; see Section 5.7.6, "Set by marker",
on page 61.

Set by marker

The "Set by Marker" functions are a convenient tool for scaling (in particular: magnify-
ing) diagrams without entering explicit numeric values. You simply place a marker to a
trace point and use the marker values to change the sweep range or move the trace
relative to the vertical axis. The touchscreen or a mouse makes it easier to activate
(touch/click) or move (drag and drop) markers.

1= Center =
Marker

+ Ref Val =
7% Marker
+ Start=

Marker

= | Stop=
Marker

n Max =
Marker

N Min =
Marker

To set the sweep range using markers, use one of the following methods.

Set "Start" and "Stop" values in the diagram:

1. Create two normal markers, e.g. the markers "Mkr 1" (default label "M1") and "Mkr
2" (default label "M2").
See Section 5.5.2, "Adding markers", on page 51.
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2. Place "M1" to the start value of the desired sweep range and tap Trace — [Marker]
> "Set by Marker" > "Start = Marker".

3. Place "M2" to the stop value of the desired sweep range and tap Trace — [Marker]
> "Set by Marker" > "Stop = Marker".

Use a definite "Span":
1. Create a marker.

2. Enable "Delta Mode" for this marker.
The analyzer automatically creates an additional reference marker.

3. Place the reference marker to the start value of the desired sweep range.

4. Set the value of the delta marker to the desired sweep range and tap Trace —
[Marker] > "Set by Marker" > "Span = Marker".

To move the trace in a vertical direction, proceed as follows:
1. Create a normal marker, e.g. the marker "Mkr 1" (default label "M1").

2. Place "M1" to a particular trace point, e.g. use the "Marker Search" functions to
locate a maximum or minimum on the trace.

3. Select Trace — [Marker] > "Set by Marker" > "Max = Marker" to move the trace
towards the upper diagram edge, leaving the values of the vertical divisions
("Scale/Div") and the overall vertical scale unchanged. Analogously, select "Min =
Marker" to move the trace towards the lower diagram edge, or select "Ref Val =
Marker" to move the trace towards the "Ref Value".

O You can also use marker values in the "Numeric Editor"; see Section 5.6.2, "Using the
= numeric editor", on page 55.

5.7.7 Enlarging a diagram

The analyzer provides different tools for customizing the contents and size of the dia-

grams:

e Select B from the toolbar to maximize the active diagram. Or, equivalently, select
System — [Display] > "Diagram" > "Maximize Diagram".
If enabled the active diagram is always maximized.

® Double-tap/click a diagram to maximize it and make all its traces except the active
one invisible.

® The "Menu Bar", the "Status Bar", the "Hard Key Panel", and the "Title Bar" can be
hidden to gain space for the diagrams (System — [Display] > "View Bar").

® The System — [Display] > "Config" softtool tab defines optional display elements for
the interior of the diagrams.

Use the context menu of the diagram, the System — [Display] key or the "Display”
menu to access the display settings.
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6 Performing measurements

This section takes you through a sample session with a R&S ZNB network analyzer
and describes basic operation tasks.

in Section 3, "Preparing for use", on page 13.

@ Prerequisite
The instrument is set up, connected to the mains system, and started up as described
O Use the "S-Parameter Wizard" accessible via

Trace — [Meas] > "Measurement Menu: S-Parameters" > "S-Params" > "S-Param Wiz-
ard"

to measure S-parameters in a straightforward way. The wizard provides a series of dia-
logs where you can select the test setup, screen configuration and measurement
parameters, configure the essential channel settings and perform a guided calibration.

5-Parameter Wizard

W
measurement tasks.

Please note that all current settings except calibration data will be overwritten.

Measurement stages in the wizard

The individual dialogs of the "S-Parameter Wizard" correspond to the typical stages of
any measurement:

1. Prepare the measurement.
2. Select the test setup.

3. Define port impedances.
4

Select the measurement parameters and the diagrams.
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6.1

6.1.1

Transmission S-parameter measurement

5. Define the sweep range.
6. Adjust the source and receiver settings (source power, measurement bandwidth).

7. Perform a calibration (optional).

Transmission S-parameter measurement

In a transmission measurement, the analyzer transmits a stimulus signal to the input
port of the device under test (DUT) and measures the transmitted wave at the DUT's
output port. The trace settings allow you to select the measured quantities and display
formats, depending on what you want to learn from the data. A minimum of two ana-
lyzer test ports are required for transmission measurements.

In the following example, the analyzer is set up for a two-port transmission measure-
ment. A frequency sweep range is selected, the instrument is calibrated and the mea-
surement result is analyzed using various display formats.

Connecting the instrument for transmission measurements

To prepare a transmission measurement, you have to connect your DUT (which for
simplicity we assume to have appropriate connectors) in-between a pair of analyzer
test ports. It is recommended that you preset the R&S ZNB to start from a well-defined
instrument state.

VNA

OO

1 DUT >

1. Connect the DUT between test ports 1 and 2 of the network analyzer as shown
above.
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Transmission S-parameter measurement

2. Use the [Preset] key to restore a well-defined instrument state.

The analyzer is now set to its default state, measuring the transmission S-parame-
ter Sy4.

Trel dB Mag 10 dB/ Ref 0 dB

O Drag&drop the @ toolbar icon onto the diagram area to create additional traces (and
= diagrams).

6.1.2 Selecting the sweep range and other parameters

After a system preset the display shows a diagram with a dB magnitude scale, and the
S-parameter S, is selected as a measured quantity. This S-parameter is the forward

transmission coefficient of the DUT. It is defined as the ratio of the transmitted wave at
the DUT's output port (port no. 2) to the incident wave at the DUT's input port (port no.

1),

The R&S ZNB automatically adjusts its internal source and receiver to the selected
measured quantities: For an S,; measurement, a stimulus signal (termed a,) is trans-
mitted at the analyzer port no. 1; the transmitted wave (termed b,) is measured at port
2. The stimulus signal from the analyzer port no. 2 is not needed except for some cali-
bration types.

By default the sweep range is set to the frequency range of the analyzer, which can be
unsuitable for your DUT. The following procedure shows you how to configure a
smaller sweep range.

1. Select Stimulus — [Start] and set the "Start Frequency" to the lowest frequency you
want to measure (e.g. 1.77 GHz).
For convenient numeric entry, double-tap/click the input field to open the "Numeric
Editor" (see Section 5.6.2, "Using the numeric editor", on page 55).

Tip: If you use the data entry keys at the front panel for data entry, type [1][.][7][7]
and terminate the entry with the [G/n] key.

Refer to Section 5.6, "Entering data", on page 54 to learn more about entering
numeric values and characters.

2. In the "Stop Frequency" input field, enter the highest frequency you want to mea-
sure (e.g. 2.5 GHz).

3. Select Trace — [Scale] > "Scale Values" and activate the "Auto Scale Trace" func-
tion. The analyzer adjusts the scale of the diagram to fit in the entire S, trace,

leaving an appropriate display margin.
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0,

6.1.3

Transmission S-parameter measurement

Trcl dBMag 0.2 dBf Ref-5.8 dB

Chl Start 1.77 GHz hwr -10 dBm

Tip: Refer to Section 5.7, "Scaling diagrams", on page 57 to learn more about the
different methods and tools for diagram scaling.

By default, data acquisition at port 2 starts immediately. For DUTs with large group
delay (> ~10 ns), and if the sweep is optimized for speed, the data acquisition window
can partly overlap with the signal from the previous sweep point. In this case, it is rec-
ommended to configure an additional measurement delay: Start with a measurement
delay of 0, and increase it until the S,, trace becomes stable.

Calibrating the instrument

Calibration (system error correction) is the process of eliminating systematic, reprodu-
cible errors from the measurement results. E.g., in the current test setup, the connect-
ing cables between the analyzer ports and the DUT introduce an attenuation and a
phase shift of the waves. Both effects impair the accuracy of the S-parameter mea-
surement.

The analyzer provides a wide range of sophisticated calibration methods for all types of
measurements. The calibration method to select depends on the expected system
errors, the accuracy requirements of the measurement, on the test setup and on the
types of calibration standards available.

The following example requires a calibration kit with a male Through standard with
known transmission characteristics for the related test port connector type and gender.
With a single Through, it is possible to perform a transmission normalization, compen-
sating for a frequency-dependent attenuation and phase shift in the signal paths.

Due to the R&S ZNB's calibration wizard, calibration is a straightforward, guided proc-
ess.

1. Replace the DUT by the Through standard of your calibration kit. Make sure to dis-
connect all calibration units.

2. Select Channel — [Cal] > "Start (Manual)" to open the "Calibration Setting" wizard.

3. Pick port 1 (P1) and port 2 (P2), choose the calibration type "Trans Norm", and
select port 1 as source port.
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Transmission S-parameter measurement

Calibration Setting
1
Ports and Type

Configuration

P ° P2 °

Refl Refl Refl OSM Trans Trans One Path ~ TOSM UOSM 3 NIST TOM TSM TNA Adapter
Norm Norm Norm Norm Two Multiline Removal
Open Short Both Ports TRL

Source

4. Select "Next" to proceed to the next page of the "Calibration Setting" wizard.

5. Select the test port connector type and gender (here: N 50 Q, female, correspond-
ing to a male Through standard), and the calibration kit (here: R&S ZV-Z121).

Calibration Setting

1 2
Ports and Type Connectors and Cal Kits
Calibrations

Trans Norm P1(Source), P2

Configuration

Connector N500 b N 500 M

ort G v
Port Gender Female Female

el vz Nz

Kit Modified
Additional Settings

Same Connector Same Gender all »
all Ports l:‘ Ports l:‘ ﬁ Import Cal Kit

4 Previous @ Start

6. Tap"Start".

7. The calibration dock widget indicates the standard measurements that make up a
"Trans Norm" calibration.
Select "Through (mm)" to initiate the measurement of the connected Through stan-
dard. Measuring the isolation between ports 1 and 2 is optional. Skip it for now.
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Transmission S-parameter measurement

Trc1 74N dB Mag 10 dBf Ref 0dB  Cal Off Trc2 p740 Phase 45°f Ref 0° Cal Off

Ch Start 1GHz  Pwr -10dBm Bw 10 kHz Trans Norm P1,P2 Stop 5GHz Rl Start 1GHz  Pwr -10dBm Bw 10kHz Trans Norm P1,P2 Stop 5 GHz

P1Q—Q P2
N 500 (f)
N 50 0 Ideal Kit

T Through
(mm)

| Isolation

Calibration -- Ch1

Restart Sweep on Std. Continuous Cal
X A P o

Abort Meas. L Sweeps

The analyzer performs a calibration sweep for the measured quantity S,;. The
magnitude and phase of the result is displayed in two diagrams, together with the
expected typical result for a Through standard. The similarity of real and expected
traces indicates that the Through standard has been properly connected. After the
R&S ZNB has completed the calibration sweep and calculated the correction data,
the "Apply" button is enabled.

8. Select "Apply" to close the wizard.

The system error correction is calculated and applied to the current channel. A
"Cal" label appears in the trace list.

To proceed with the measurement, remove the Through standard and connect the DUT
again.

6.1.4 Evaluating data

The analyzer provides various tools to optimize the display and analyze the measure-
ment data. For instance, you can use markers to determine maxima and minima on the
trace, and change the display format to obtain information about the group delay of the
transmitted wave.

1. Select Trace — [Marker] > "Markers" > "Mkr 1".
This places marker "M1" to its default position (center of the sweep range). A
marker symbol (triangle) appears on the trace, a marker info field in the upper right
corner of the diagram. The marker info field displays the stimulus value (frequency)
and response value (magnitude of the transmission coefficient converted to a dB
value) at the marker position.
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Chl Start 1GHz Pwr -10dBm Bw T0kHz

2. Select Trace — [Marker], activate the "Marker Search" softtool tab and activate

"Min" search.
The marker jumps to the absolute minimum of the curve in the entire sweep range.
The marker info field shows the coordinates of the new marker position.

3. Select Trace — [Format] and choose the "Delay" of the transmission coefficient as

the displayed quantity.

The group delay represents the propagation time of the wave through the DUT; it is
displayed in a Cartesian diagram. The marker info field shows the frequency and
group delay at the marker position.

Chil 5tart 1GHz Pwr -10dBm Bw T10kHz Stop 6 GHz

Refer to the information on trace formats in the help system or in the user manual to
learn more about the diagram properties.

Saving and printing data

The analyzer provides standard functions for saving measurement settings and for
saving or printing the results. You can use these functions as if you were working on a
standard PC. Moreover you can export your trace data to an ASCII file and reuse it in a
later session or in an external application.

Data transfer is made easier if external accessories are connected to the analyzer or if
the instrument is integrated into a LAN. Refer to Section 3.11, "Connecting external
accessories", on page 21, and Section 3.12, "Remote operation in a LAN", on page 23
to obtain information about the necessary steps.
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6.2

Reflection S-parameter measurement

Activate the System — [File] > "Trace Data" softtool tab.

In the "Trace Data" softtool tab, select "Export" — "ASCII" to open the "Export Data
- ASCII Files" dialog.

In the "Export Data - ASCII Files" dialog:

a) Select a file location ("Look in:").
b) Enter a filename ("File name:").
c) Select "Save".

The analyzer writes the data of the active trace to an ASCII file and closes the dia-
log.
Activate the "Print" softtool tab (System — [File] > "Print").

In the "Print" softtool tab, select "Print" to print the diagram area or "To Clipboard"
to copy it to the Windows clipboard.

Select System — [File] > "Recall Sets" > "Save" to open the "Save" dialog for recall
sets.

In the "Save" dialog:

a) Select afile location ("Look in:").
b) Enter a name for the recall set file ("File name:").
c) Select "Save".

The analyzer saves the active recall set, containing channel, stimulus and trace
settings, to a znx file. This recall set can be restored in a later session.

Reflection S-parameter measurement

In a reflection measurement, the analyzer transmits a stimulus signal to the input port
of the device under test (DUT) and measures the reflected wave. Different trace for-
mats allow you to express and display the results, depending on what you want to
learn from the data. Only one analyzer test port is required for reflection measure-
ments.

In principle, a reflection measurement involves the same steps as a transmission mea-
surement. Note the following differences:

The basic test setup for reflection measurements involves a single DUT and ana-
lyzer port. For instance, you can connect the input of your DUT to port 1 of the ana-
lyzer as shown below.
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Reflection S-parameter measurement

VNA

1 DUT

You can also use the basic transmission test setup, e.g. if you want to measure
reflection and transmission parameters in parallel.

® The analyzer provides special calibration types for reflection measurements (Refl.
Norm., OSM, ...). Use the calibration wizard and select an appropriate type.
A full n-port calibration (TOSM, UOSM, TNA ...) corrects the system errors for all
transmission and reflection S-parameters.

® Some of the trace formats are particularly suited for reflection measurements. For
instance, you can display the measured reflection coefficient Sy, in a Smith chart to
obtain the complex input impedance at DUT port 1.

Chl Start 1.77 GHz Pwr -10 dBm
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7.2

7.3

Firmware installation

Firmware update

Admin account

You need administrator rights to install a new firmware. See Section 3.9, "Windows
operating system", on page 18 for details.

64-bit only

For analyzer firmware versions = 3.0, 32-bit Windows is no longer supported. Only 64-
bit firmware is available.

To upgrade your instrument to 64-bit Windows 10, contact Rohde & Schwarz service.

Update information

Rohde & Schwarz firmware releases are thoroughly tested concerning backward com-
patibility of features and performance.

A prerequisite for publishing a new firmware release is the fact that according to our
test results a re-calibration is not required after updating an instrument to this new ver-
sion.

Firmware downgrade

Generally, it is not recommended to use an earlier version than the latest version avail-
able. In some cases, the older versions do not support the hardware used in your
instrument.

Usually you can downgrade to a previous version by executing the related firmware
setup file.

Downgrade to an earlier firmware version
To downgrade the firmware from a version = 4.00 to an earlier version, it is required to

uninstall the firmware using the uninstall shortcut on the Windows desktop before
proceeding with the installation.

Firmware installation

The analyzer firmware is supplied as a single executable setup file (* . exe).
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Firmware installation

To install the firmware:

1. Copy the setup file to any storage medium accessible from the analyzer. This can
be either the internal mass storage drive, an external storage medium (USB flash
drive, external CD-ROM drive) or a network drive (LAN).

The default name of the internal drive is C:. External storage devices are automati-
cally mapped to the next free drive, i.e. D:, E: etc.

2. Run the setup file from the Windows® Explorer. Follow the instructions of the setup
wizard.
Setup files can be reinstalled.
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8 Contacting customer support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz product, contact our customer sup-
port center. A team of highly qualified engineers provides support and works with you
to find a solution to your query on any aspect of the operation, programming or applica-
tions of Rohde & Schwarz products.

Contact information

Contact our customer support center at www.rohde-schwarz.com/support, or follow this

QR code:
[ |

Figure 8-1: QR code to the Rohde & Schwarz support page
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